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Compatibility for Operating Systems – First of all we have simplified installation and user rights 
requirements for the software. We feel this is quite important because in the XP, Vista and 
Windows 7 environments there were difficulties requiring you to be logged in as a System 
Administrator in order to install or to work with codes or to update the software.  

 
This could be fairly difficult and tedious in areas where there was a fair amount of lock down on 
user privileges so the software has been redesigned and the security system is been redesigned 
such that you can login as a “standard” user, without a requirement for power user privileges, to 
work with the licensing and for normal operation of the software. You will still need “full control” 
rights over directories where your projects are stored, as before. 
 
This has specific advantages for Vista and Windows 7 systems. Version 8 will not require 
“elevation” of user privileges to run SOLIDCast or any of its modules and utilities. 
 
Administrative privileges are still required for installation, but Vista and Windows 7 systems will 
prompt you during installation at the point those rights are needed. We have also eliminated the 
need, for antivirus or other security packages to be disabled just to get a successful install, as was 
required in some cases for version 7. 
 
In short, download or get the CD, and run the installation program; it should install without trouble 
and work the first time without special instructions. 
 
Another adjustment to the installation process is that instead of having to do three separate 
installation routines, one for each of the modules SOLIDCast, FLOWCast and OPTICast, with 
version 8 of the software it will all be able to be done as one single process. Also, within a 
company, individual requests for licenses can be sent to Finite Solutions and then they can all be 
combined and fulfilled with the single license file that can be distributed everyone in the plant. This 
is also an excellent way to license the software in computer labs at schools. 
 
Materials List Improvements – The next new feature is a greatly expanded functionality in the 
Materials List. The Materials List has been increased in size so that the data is more easily 
readable, especially in the Curves Function, and the material has been reorganized, not only 
internally in the database, but also externally, so that you can work with it and make adjustments 
more easily. There have also been expanded functions within the material types that will allow us 
to do further development work on things such as mold permeability and entrapment of air and 
gases during a filling simulation. For cast irons, the Iron Property Calculator utility has been 
integrated into the Materials List, so you can automatically adjust curves for cast irons, based on 
an initial simulation on an unrigged casting. Access to the cast iron riser design function is also 
provided here. 
 
Licensing Improvements – System security has been improved not only to make the package 
more reliable but also to simplify the use in licensing and keeping your system going. Licensing 
will be able to be done over the phone, via e-mail and also with direct requests on the Internet. 
This should greatly simplify the exchange of system codes and license files, and make it easier for 
you to get your system up and going without having to wait for a phone call or response from 
Finite Solutions. 



Queue Function for Fluid Flow and Solidification Simulations – There is a new queuing 
function for both FLOWCast fluid flow simulations and for SOLIDCast solidification runs. These 
can work together or independently and this allows you to make better use of computer time when 
someone would not normally be using the computer. In other words you can set up your models 
and meshes, get things ready to run a simulation and then put that fluid flow simulation or 
solidification run into the project queue. When you're ready to leave for the day you can then start 
the queue running and the system will automatically load the models or meshes, run the 
simulation, save the results and go on to the next. So the net result would be when you come in 
for work the next day you have all your simulations done and ready to go. 
 
Multiple Instances of FLOWCast and SOLIDCast – There is an expanded ability to run multiple 
FLOWCast simulations and multiple SOLIDCast runs at one time. This is not the same as multi 
threading, where you actually use multiple processors to run a single simulation at a faster rate, 
but this allows you to run multiple simulations at the same time, taking advantage of multiple core 
processors. This can give you a much higher throughput, as long as you have enough system 
memory in order to handle the processes. 
 
New System Utilities – There have been more than a dozen new system utilities that have 
gradually been added to the system. They are all fully implemented in version 8 of the software. 
These new utilities include: 
 
Create STL File from ISO-Surface - This utility allows you to take ISO-Surface plot data and 
export it as an STL file. This was so that it would be possible to take SOLIDCast information and 
place it into a CAD model in the original CAD system, to facilitate placement of risers, etc. 
 
Convert or Import Version 7 Materials Database – This utility allows you to replace or merge 
data from an existing SOLIDCast materials database (pre-version 8) with the new data provided 
with version 8 of the software. 
 
Extract Thermocouple Data - This utility will take time-temperature data created by SOLIDCast, 
and export it out into a text file, for use in plotting in other software packages, such as 
spreadsheets. 
 
Four Point Fill - In this utility, pouring starts at two points. Then, at a given percent full, pouring 
begins at two additional points so that in the second stage of pouring all four pour points are 
active. In this scenario, the incoming flow rate at each pour point is equal, which means that the 
total rate of flow in the second stage of pouring is twice that of the first stage, and the mold fills 
faster during the second stage than during the first. Note that this utility only works for FLOWCast 
filling and not with the SOLIDCast simplified filling algorithm. 
 
QuickPlot - This utility is patterned after the Simulation Image Control utility. QuickPlot allows you 
to change resolution, plotting angle and data types very quickly. By clicking on slider bars, new 
plots are made instantaneously, and you can create live animations by holding down the slider 
bar. 
 
Reset Simulation Stop Point - This utility is used to change the point at which SOLIDCast 
assumes that the simulation is complete. When you first start a simulation, you can choose from a 
number of options to end the simulation. The default setting is when both the Casting and Riser 
materials are 100% solid. However, you may want to run to a certain time, or to a certain 
temperature in the casting, or even run until a manual stop. Then, after examining simulation 
results, you may want to change the stop point in order to continue simulating for a longer time. 
This utility allows you to make that change. 



Reuse FLOWCast Results - This utility allows you to take the temperature distribution in a model 
calculated by a FLOWCast filling simulation, and place it into another mesh of the same size. 
Note that the X, Y and Z number of nodes must be exact from one mesh to the other in order to 
use this utility. 
 
Riser Design - This utility gives ‘direct access’ to the riser design functions of SOLIDCast, without 
going through the riser design wizard. Sometimes, this can be more efficient, if you are just 
looking for a modulus calculation, or to check on a riser size. 
 
Riser STL Shape - This utility allows you to create a riser and contact by entering values for riser 
size, contact size and taper. The result is saved as an STL file, that can then be brought into a 
SOLIDCast casting model. 
 
Set Up Point/Temperature Stop - This utility allows you to specify a given  X, Y, Z location in a 
model to be used to monitor temperature. Once the temperature at that spot reaches or drops 
below the specified set point, the simulation will stop. This differs from the default temperature 
stop point in that it is for a specific location in the model, not the maximum temperature in the 
whole casting (or riser). 
 
Set Up Variable Furnace Temp - This utility helps you to set up a furnace temperature ‘ramp-up’ 
schedule for a heat treat simulation. You can set up to 15 time-temperature set points, and you 
can activate or deactivate the schedule for subsequent simulations. 
 
Two Stage Pour - In this utility, the pour starts at Fill Point 1 and continues until a given % full is 
reached. Then flow stops from Fill Point 1. There is a pause of a given number of seconds, after 
which pouring starts from Fill Point 2 and continues until filling is complete. This utility can only be 
used with the FLOWCast filling algorithm. 
This would most often be used to simulate a ‘hot topping’, where you would initially pour a mold 
through the sprue, then move the ladle over the top of an open riser and top up the  riser with hot 
metal. 
 
Two Point Pour - In this utility, pouring starts at Fill Point 1 until a given % full is reached. At that 
point, flow also starts from Fill Point 2. Flow continues from both Fill Point 1 and Fill Point 2 until 
the end of filling. This utility can only be used with the FLOWCast filling algorithm. 
 
QuickPlot Result Viewing – The last major functionality improvement is the QuickPlot utility, 
which allows you to show simulation results very quickly and make plots and animations very 
rapidly without having to reselect data or the plot type. This function has been developed in a 
similar way to the Simulation Image Control utility that was included in version 7.2.2. You are now 
able to adjust the orientation of the view, the resolution of the view and the data you're working 
with very rapidly, as well as to re-plot almost instantaneously; like you can do in the Cut Plane 
Plot, but in this case doing it on a three-dimensional color model. 
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Changes and Updates Through Version 7.2.2 

October 24, 2008 

 
1.  New display during SOLIDCast simulation which offers higher resolution, variable views and 
variable display methods (show all nodes or transparent nodes under solidification or CFS point).  
This includes a new entry on the Tools menu called Simulation Image Control which allows the 
user to select the display mode, either prior to running a simulation or while the simulation is 
running. 
  
2. Updated version of the Iron Property Calculator Tool.  In the Riser Design portion of this tool, 
the riser efficiencies have been adjusted for more accuracy. 
  
3. Correction of empty-mold temperatures during filling, when using the SOLIDCast Fill Algorithm. 
 
4. An improvement in the way FLOWCast is started on Windows Vista systems. 
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Changes and Updates Through Version 7.1.2 

April 28, 2008 

The Two Stage Pour… utility has been added. This function was created to assist in creating a 
setup file for FLOWCast, allowing you to do automatic ‘hot topping’ of risers, by filling the casting 
a certain percentage, pausing, then finishing the fill from the top of a riser or risers. 
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Changes and Updates Through Version 7.1.1 

March 10, 2008 

The Save Project As… function has been reworked, due to internal changes in Windows XP and 
Vista. The previous version would create a new project folder, but would not properly copy all the 
existing files. This has been corrected. 

The Minimize button in the Gating Design Wizard has been removed. The window can be moved 
if you need to see anything behind it, but it cannot be minimized. 
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Changes and Updates Through Version 7.1.0 

February 4, 2008 

 
The Cast Iron Properties Utility Program has been extensively overhauled so that it is now a 
synthesis of both the VDG Nomograms and the Karsay charts, which increases the accuracy of 
this calculation.  A slider bar for Metallurgical Quality has been added, as well as a selector for 



Ductile Iron, Grey Iron or CG Iron.  The program now calculates the amount of expected 
expansion and displays the exact points needed to build the Shrinkage Curve as well as set the 
Critical Fraction Solid for the alloy. 
  
The Gating Design Wizard has been modified as follows: 
  

a.)  There is now a slider bar which you can use to specify an Efficiency Factor for pressurized 
gating calculation of choke size.  If the user specifies a non-pressurized gating system, then 
the program uses the built-in Efficiency Factors of 0.88 for a tapered round sprue, 0.47 for a 
round straight sprue and 0.74 for a tapered square sprue, as was previously done.  For a 
pressurized system, whatever is set by the user with the slider bar is now used to calculate 
the size of the choke.  A value of 0.5 is the default value when this function is first accessed.  
If the user selects a different value to use, the program remembers this value the next time 
the Gating Wizard is accessed. 
  
b.) It is no longer necessary to adjust the Gating Ratio so that the smallest number is 1.  
Previously, if you wanted to specify a Gating Ratio of 5:6:2, it was necessary to enter this as 
2.5 : 3 : 1.  Now, entering 5:6:2 will give exactly the same results as entering 2.5 : 3 : 1. 
  
c.) Previously, the size of the top of the sprue was displayed as the same as the bottom of the 
sprue for a round straight sprue.  This has been modified so that the size of the top of the 
sprue is calculated from the formula: 
  
Atop   =  Abottom * sqrt(SprueLength / DepthOfMetalInPouringBasin) 
  
for all 3 sprue types. 

  
Reset Simulation Stop Point:  A new utility program has been added which allows the user to 
change the stop point of a simulation.  For example, if a simulation has completed with all of the 
casting alloy at 100% solid, it is now possible to change the stop point to specify a maximum 
temperature in the casting, then restart the simulation and run until that maximum temperature 
has been achieved. 
  
Riser STL Shape: A new utility program has been added which will create a single STL file 
representing a riser and a neck, based in input of dimensions by the user. 
  
The Shell Creation Utility Program has been rewritten.  Previously, when shelling over large flat 
areas the shell would sometimes be generated with ridges or waves.  This effect has been 
eliminated, and these areas of the shell should now be generated as smooth surfaces. 
  
The Meshing Program has been modified to handle castings which are very complex in the 
horizontal plane. 
  
The View Factor Calculation program has been modified to properly handle meshes with larger 
numbers of nodes in orthogonal directions.   
 
FLOWCast version 1.71 has been released. Internal changes have been made to be able to 
handle unusual filling sequences, such as filling from more than one location, at more than one 
time. This would include pauses after initial filling, then backfilling at another location, such as an 
open riser. Further work is being done to help automate this process, to make it easier for the 
general user to work with. 
 
Other internal improvements provide a more stable solution when working with mold materials of 
high conductivity, such as permanent molds. 
 
OPTICast – Toolbox routines have been updated for 2008 operation. 
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Changes and Updates Through Version 7.0.2 

February 16, 2007 

Materials List and FLOWCast – A problem was identified and corrected, where in some cases 
FLOWCast would mis-read a Materials List and incorrectly calculate the CFS Temperature. If this 
happened, the system would give an error saying that the Critical Fraction Solid Temperature was 
lower than the Solidus Temperature. 

 

Changes and Updates Through Version 7.0.1 

February 6, 2007 

File Save Function – Various file save functions have been improved when working with models, 
so that saving is quicker and more efficient. 

Iron Property Calculator – The iron property calculator has been improved to provide accurate 
results over a wider range of chemistry and modulus values. 

New HTC Calculator Utility – A new utility has been added to calculate appropriate heat transfer 
coefficients (HTCs) for a variety of situations, including mold coatings, air and water cooling 
channels and radiation and convection from hot surfaces. 

SOLIDCast Training Workbook Update – The SOLIDCast training workbook has been updated 
to include instructions on how to use the new HTC Calculator Utility. 
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Changes and Updates Through Version 7.0.0 

December 20, 2006 

Operating System Requirements - Version 7.0.0 of the software will now operate under 
Windows XP only. The version should be from 2001 or later. Microsoft has dropped support for 
any older operating system, and various changes to the software and movie functions require this. 
If you try to install or update to version 7.0.0 on machines with Windows 2000, NT or 9x/ME 
installed, the system will issue a warning message and prevent installation. 
 
The installation package now applies the .NET Framework, which will simplify future 
developments and updates. 
 
The installer now checks for and REQUIRES Administrator mode for both installation and 
updating. This was required in the past, but now the system actually checks for it an halts 
installation/updating if not in the required mode. 
 
New Compatibility - New compiler technology has allowed us to provide full compatibility with 
multi-processor, dual-core and Hyperthreading technologies. Previously, these functions had to be 
disabled on individual machines in order to prevent execution errors. 
 
Speed Improvements - 20% speed increase in SOLIDCast simulations, meshing, view factor 
calculations and shell creation functions 
 
Movie Making Enhancements - New higher quality WMV movie output. SOLIDCast movies still 
remain quite compact, but the picture quality has been dramatically improved. Movies are much 
clearer and vivid. Also, iso-surface movies have been adjusted to be created in the background, 
like the other movie functions, so that you can work on other things while the movie is being 
created. Previous AVI movies were created using the INDEO Codec, which is no longer a 
standard part of Windows. The new WMV format is supported by any reasonably recent version of 
the Windows Media Player. FLOWCast movies continue to be created in AVI format, but they did 
not rely on the INDEO Codec. 
 
New and Improved Utilities - A number of utilities have been added. Others have been improved 
or expanded. And several have been newly documented in the version 7.0 training workbook. The 
utility changes are listed below: 
 
Data Capture (Temperature)...: This utility is used to create a grid of thermocouples that can 
track temperatures in the casting and mold. While not a new utility, it has been completely 
documented in the training workbook. 
 
Early Fill Tilt Pour...: (New) Allows you to specify a point in tilt pouring when most or all metal 
has filled the mold, prior to completion of the tilt. For example, you could set the system to pour 
90% of the metal during the first half(45 degrees) of a 90 degree tilt pour. 
 
Filter Shape...: (New) Creates a rectangular filter shape with specified open area as an STL file. 
The STL can be added to a SOLIDCast model to simulate metal flow through the filter. 

Iron Property Calculator...:  Previously, properties of iron castings modulus with values of more 
than 3 cm (1.18 in.) were calculated as though the modulus were 3 cm due to limitations in the 
VDG Nomograms. The range of the program has now been extended to calculate iron 
properties for heavier castings. Both property calculations and riser design functions of this utility 
have been completely documented in the training workbook. 
  



Ladle Calculations...:  In the previous version, fill times of over 100 seconds caused an error to 
occur in FLOWCast.  This has been corrected. 
  
Mask Material Density in Risers...: This utility has been completely documented in the training 
workbook. 

Project Viewer...: The Project Viewer Utility now displays the number of STL surface facets in a 
model.  
  
Simulation Parameters...: (New) This lets you adjust some system settings that previously 
required manipulating files in the SOLIDCast folder. These settings are: 
  
 - Reduce Mold/Metal HT Coefficient at Solidus Point (for Permanent Mold) 
 - Thermal Center Feeding (for Riserless Iron Castings) 
 - Low Pressure Simulation 

 - SOLIDCast Fill Tuned for Horizontal 
 - SOLIDCast Fill Tuned for Vertical 
 - Thermocouple Time Step Save Increments 

  
Solidification Time Gradient Calc (New)...: Calculates gradients in the casting based on 
Solidification Time. This has been used to predict the likelihood of hot tears in the casting. 
 
FLOWCast Version 1.59 - The current version of FLOWCast includes the following changes 
since 1.49, which was distributed with version 6.3.40 of SOLIDCast: 
 
- Stop Flow Temperature now defaults to the CFS Point, and is user adjustable. It used to be 
locked at the Solidification Temperature. 
- Velocity Vector Plotting on 2-D cuts through the 3-D model can highlight both direction and 
speed of metal flow, showing swirling, eddies, etc. 
- New Interface Controls that work very similar to SOLIDCast. 
- Tilt-pour capability to fill the mold before tilting is complete. 
- Centrifugal casting filling capability has been added. This is an initial release, and functionality 
will be improved and expanded. 
- Improved handling of cooling channels. 
- Improved data handling and animation of variable flow rate simulations. 
- Non-blocking messages added for cyclical simulations in permanent molds. 
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Changes and Updates Through Version 6.3.40 

July 1, 2005 

 

FLOWCast is now ‘3GB Aware’ – To help run larger fluid flow simulations, FLOWCast has 

been made ‘3GB Aware’ in version 1.49. The program can now use up to 3GB of RAM for one 

simulation. Normally, Windows will allow 2GB to be used by one program at a time. In order to 

take advantage of this, you need to adjust the startup file for Windows. Instructions on how to do 

this are available from FSI and will be added to the FLOWCast Training Workbook. 

 

SOLIDCast ModelView Window Fix – In more complex models, it was possible during editing 

to get a blank ModelView Window popping up, which seemed to either eliminate a model, or 

hide it from view. Previously, the only solution was to exit SOLIDCast, restart the program, and 

reload the model. The mechanism of this problem has been identified and corrected. 
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Changes and Updates Through Version 6.3.39 

January 1, 2005 

 

Updated Routines for OPTICast – The HyperOpt® library routines that form the controlling 

basis for OPTICast have been updated. All users of the OPTICast module need to run the update 

program in order to use these new routines. 

 

 

SOLIDCast™ Version Update Documentation  
Changes and Updates Through Version 6.3.38 

December 28, 2004 

 

New Routines for Taiwanese Chinese Characters – Some of the routines in SOLIDCast 

caused problems when running the software using the Taiwanese Chinese Character Set. These 

difficulties have been corrected. 
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Changes and Updates Through Version 6.3.16 

November 11, 2004 

 

Cast Iron Riser Design Function – Riser design features for cast irons have been directly added 

to the Iron Property Calculator Utility. This function will help you to design both top and side 

risers, using both long and short riser necks. Using the Iron Property Calculator, you can fine 

tune your cast iron properties, then properly design a feeding system, based on the amount of 

shrinkage time for that particular alloy and section size. 

 

A detailed PowerPoint presentation on the use of this new function is available, either on the 

Version 6.3.16 CD, or from the New Developments section of the FSI website, 

http:/www.finitesolutions.com. 

 



STL File Import Error Fixed – An error was introduced in version 6.3.15 in the STL import 

function. As a file was imported, it was rotated and mirrored. This error has been corrected.
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Changes and Updates Through Version 6.3.15 

August 23, 2004 

 

Shape Creation Logging Function Added – A new feature was added to create a log of steps 

taken during shape creation in the model builder. By default, this function is turned off. This 

utility was created in order to help troubleshoot model building problems. Running the short 

program, SCLOGGER.EXE, turns on this function. 

 

Unusual Coordinates in Pick Point Routines – It was discovered that when trying to click very 

close to the edges of some parts, to get the X, Y, Z coordinates, it was possible to generate some 

extremely large and/or small numbers. If this occured during a shape creation, it was possible to 

add an object that may be, literally, miles away from the rest of the model. The result of this 

operation was that a zoom full appeared to make the model disappear. The selection code has 

been modified so that only reasonable and correct numbers result for X, Y, Z coordinates. 

 

Update Program Procedures Modified – The SOLIDCastUpdate program procedures have 

been modified, so that in most cases, you do not require a new set of Response Codes. 

Previously, if an update was run, the system was deactivated until a new set of System Codes and 

Response Codes were generated and entered. 

 

Symmetry Added to Bottom Pour Ladle Utility – This utility has been updated, to 

automatically take into account the use of planes of symmetry in a model. 

 

FLOWCast 1.45 Release – Many new functions have been added to FLOWCast. These include: 

 

1. Database changes were made to FLOWCast that help A LOT in reducing the amount of 

memory used for castings with thin walls. The simulation results are identical except that 

with a memory restructuring the amount of memory used is much less.  It is 100% backwards 

compatible, namely, all saved time step files can be loaded without any problems, except that 

when you load saved simulation files, or when you launch FLOWCast in a directory project 

containing saved time steps, depending on the  simulation it may take some CPU time until 

the data structure is converted, but this will only be noticeable for some larger models, 

otherwise the difference will be minimum. 

 

2. Now most of the memory allocated by FLOWCast is freed when FLOWCast exits, however 

as long as the process remains alive there will be ~  40 MB that will remain allocated, this is 

code, dlls, static memory, etc. 

 

3. Change have been made that will speed up simulations a lot for huge models. 

 

4. Now FLOWCast should be faster than before for models with thin walls. 

 

5. For some cases the amount of memory used for Pathlines is now greatly reduced. 

 

6. Memory from the equations solver is now freed more quickly. 

 

7. A new feature detects difficulties in filling due to castings with thin walls and changes from 

Velocity-Pressure at inflow to Velocity at inflow. 



8. For monitoring purposes a new file FLOWCast_mem.txt is created in the project directory. 

 

9. An additional change has been made to FLOWCast, now when checking for available 

memory, the check is based on "physical" memory, and not on “commitable” memory. 

 

10. Speedups have been added for the problem of very slow vertical filling into a very large 

casting. Also, for that particular problem we have increased the maximum speedup to "6". 

However, even if you set a large value for the speedup, a lower value may be used by the 

code depending on many parameters, timings, etc. 
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March 30, 2004 

 

Conversion Error Fixed – When in Metric units, it was possible to create a conversion error 

that would increase both the node size and the mold thickness. This error has been identified and 

fixed. 

 

Bottom Pour Ladle Utility Updated – The ladle utility has been updated, and now interfaces 

directly with FLOWCast. The utility can create a variable flow rate file, which is then processed 

automatically during a FLOWCast filling simulation. 

 

Riser Density Mask Utility - A new utility has been added with allows you to mask out the 

Material Density Function in Riser Material, leaving only the data in the casting. This can be 

quite useful if you have a complicated rigging system. Masked data can be restored at any point. 

 

FLOWCast 1.33 Release – Many new functions have been added to FLOWCast. These include: 

 

1. Support of variable mold filling rate through the use of file FlowRates.fil. This file can 

be created using the Bottom Pour Ladle Utility in SOLIDCast. 

 

2. When file FlowRates.fil is not used (standard), then the velocity of the melt across 

fill/casting cells is computed using: a) Casting/riser volume, b) Specified fill time, and c) 

Total area of fill-casting/riser cell interfaces. If this velocity is "larger" than the free fall 

velocity from a ladle height equal to 3 times the casting height, then the user is notified, 

and it is suggested to increase the fill/casting interface area, the model is loaded, but the 

simulation will not be done. 

3. With or without the FlowRates.fil file, when the Velocity of the melt across fill/casting 

cells is "smaller" than the free fall velocity from a ladle height equal to 0.25 times the 

casting height, then a number of fill cells are deactivated to increase the Velocity of the 

melt across fill/casting cells to a value close to the free fall velocity from a ladle height 

equal to 0.25 times the casting height.  

4. For models created with fill material sections (typically cylinders) that are very long 

(they penetrate the casting volume), FLOWCast automatically selects a subsection of the 

fill/casting cell interfaces through which the melt is flowing. 

5. When multiple fill points are used the total filling rate is divided among the fill points 

proportionally to the area of fill/casting interface of each fill point group. 

6. Deactivation of perspective rendering is now possible. 

7. When variable filling rate is active (file FlowRates.fil is used), there is a checked box on 

the Filling Tab. 
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Changes and Updates Through Version 6.3.4 

January 26, 2004 

 

Installation Routine Changes –  The installation/security routines have been changed, to fix 

problems that were happening on some machines. The new routines require that you be logged 

on as System Administrator when you install, and when creating System Codes and entering 

Response Codes. If you have received one or more Registry Errors during an install/update, these 

problems should be corrected. 

 

FLOWCast Speedup –  The FLOWCast solver has been further optimized, to provide a 3x 

speedup on smaller models, and up to a 12x speedup on large models. Memory usage during 

simulation has been reduced, too. 

 

FLOWCast Temperature Saves for Animation – You can now specify a different save 

increment for Temperature data versus the Full Save. This allows you to save more temperature 

data, for use with creating animations, but save less velocity and pressure information. This 

reduces the overall file size for a saved simulation, yet still allows you to create smooth, detailed 

animations for temperature. 

 

FLOWCast Display Increment – You can now adjust the rate at which the FLOWCast display 

screen is updated during a simulation run. The increment can now go as low as 0.05%. A more 

frequent display update gives you a better feel for how fast the simualtion is progressing. 
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Changes and Updates Through Version 6.3.2 

October 30, 2003 

 

Multilingual Support -  New language support has been added, to allow SOLIDCast to be run in 

several languages. These languages include : 

 

English 

Italian 

French 

Chinese Taiwan 

German 

Spanish 

Portuguese 

 

A stand-alone Russian language version is available, which will be integrated into the main 

system as well. 

 

New System Utilities – Two new system utility programs were added, Data Capture and Ladle 

Calculations. In the past a number of users have asked for the ability to save more temperature 

information in SOLIDCast than what was available using thermocouples.  

  

To use Data Capture, you will need to create a text file which contains the (x,y,z) coordinates of 

the locations at which you want to collect the temperature data.  SOLIDCast will then create a 

text file which contains the resulting temperature data. We should caution you that you should be 

careful to use a large Data Capture Interval so that the output data file does not grow too large. 
  

Also, we need to point out that this is Version 1.0 of this feature. At this point, the Data Capture 

feature does not capture data during multiple permanent mold cycles. Only the temperature 

during the last cycle will be captured. At a point in the future we will release Data 

Capture Version 2.0 which will include the ability to capture multiple cycles of data. If you are 

simulating only one cycle, then this issue is of no concern, of course. 

 

The ladle utility helps calculate specifics for bottom pour ladles. Since metal exits the bottom of 

a bottom pour ladle(surprise!), the flow rate from the ladle varies during a pour because the metal 

height varies. The flow rate slows as the metal height drops during a pour. This utility can 

calculate the amount of metal in a ladle, based on dimensions, and can also calculate 

instantaneous pour rates and times to pour a given amount of metal. 

  

This data can then be plugged into SOLIDCast for use with filling simulations, either in 

SOLIDCast or FLOWCast. 

  

At the moment, both SOLIDCast and FLOWCast use instantaneous, or average, flow rate data. 

Future versions of this utility will be integrated as a window in SOLIDCast, and variable flow 

rate data will be calculated and used in filling simulations 
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Changes and Updates Through Version 6.2.21 

September 19, 2003 

 

Version 6.2.21 was released on this date. Changes and improvements include : 

 

Snap function – Changes were made to the snap function, to convert the snap increment when 

moving between english and metric units. A minimum snap value was also added, to insure that 

the snap value did not get too small. In the past, if the snap value was set to an extremely small 

value, it was possible to get a stack or overflow error when editing a model. 

 

Node size conversion – An addition was made that now converts the current node size setting on 

the mesh menu when moving between english and metric units. In the past, the numeric value 

was maintained, not the true size. For example, if 1 inch nodes had been specified in english 

units, when moving between units the node size would be 1 mm. Now, the node size would be 

converted from 1 inch to 25.4 mm. 

 

FLOWCast/permanent mold simulations – The following changes were made to the way 

FLOWCast handles cyclical and tilt-pour simulations.  

 

1. In previous versions, FLOWCast handled rotations about the X and Y axes differently than did 

SOLIDCast. This has been corrected, so tilt-pour simulations are handled in exactly the same 

way, using both the SOLIDCast and FLOWCast filling algorithms. 

 

2. An error was discovered and corrected involving the choice of algorithm used for the warmup 

mesh in a permanent mold simulation. 

 

3. An error was discovered and corrected which was causing the mold temperature to revert to 

the initial temperature in the last permanent mold cycle if FLOWCast was used. 

 

FLOWCast pathlines feature – FLOWCast now contains a feature to trace metal flow pathlines 

during the filling process. Metal ‘particles’ are injected into the flow stream at 5% increments, 

and you can display where those particles move to during the rest of filling. You can control the 

number of pathlines, pathline thickness and color, and whether or not pathlines are displayed 

during calculation or playback. 

 

FLOWCast ‘sticky’ parameters – Many FLOWCast parameters are now ‘sticky’, and retain 

their values from one simulation to the next. 

 

FLOWCast speedup function – This function allows filling simulations to run up to several 

times faster, by skipping some of the pressure calculations that are done at every timestep. You 

can have settings of 0, 1, 2 or 3, which indicate the number of timesteps to skip between pressure 

calculations. In most situations, a speedup of 2 will yield good results for filling, but you may see 

more ‘flotsam’, or particle splashing, than if all calculations are carried out on each timestep. 
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Changes and Updates Through Version 6.2.10 

April 18, 2003 

 

Version 6.2.10 was released on this date.  The following changes were included in this 

release : 

 

Gating Design Wizard  -  The gating design function is now a fully-integrated Wizard in 

SOLIDCast (available on the Simulation menu).  This Wizard allows the user to design sprues, 

runners and gates for both horizontal and vertical gating systems.  In addition, the Wizard will 

calculate an Optimum Fill Time for a casting based on weight, alloy type and critical section 

thickness. 

 

Utility Program Menu in SOLIDCast – There is now a menu in SOLIDCast which allows the 

user to access and run all Utility Programs from within the SOLIDCast program.  This is 

available, when a model is loaded, by selecting the Tools menu.  The Utility Programs which are 

currently on this list are as follows : 

 

Convert ASCII STL to Binary  

Create Shell Around STL Shape  

Custom Formula  

Iron Property Calculator (Using the VDG Nomograms) 

Plot SOLIDCast Fill Times  

Project Viewer  

Reduce STL File Size 

Scale Model Size  

SOLIDCast Settings & System Info  

Split Files for Emailing  

STL From Model  

STL Slice  

STL of intersecting cylinders  

 

Fixed SOLIDCast Fill/Misrun Error -  In earlier versions, if you were using the SOLIDCast 

filling algorithm (not FLOWCast) and there was either a misrun or if some portion of the mold 

was not able to fill, an error occurred at the end of a simulation which referenced an Access 

Violation.  This has been corrected. 

 

Fixed Error 13-Type Mismatch  - In some non-U.S. regions, when requesting a Cast Scan or 

CastPic movie, an Error 13 was displayed.  This has been corrected. 

 

New SOLIDCast Manual – The SOLIDCast training workbook was completely revised and 

updated. The new manual is in two volumes, and contains 51 separate units. 
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Changes and Updates – Utility Program Releases 

 

 

November 22, 2002 

Gating Design Utility Program – Gating Design was released as a standalone utility program.   

This program calculates Optimal Fill Time based on weight, alloy and section thickness and 

calculates sizes for sprues, runners, gates and basins for both horizontal and vertical gating 

systems. 

 

 
January 3, 2003 

Project Viewer Utility Program – Project Viewer was released as a standalone utility program.   

This program allows you to navigate to any project folder and display summary data for any 

model, mesh or simulation in the project, including materials, initial conditions and mesh and 

simulation parameters. 

 

 
January 10, 2003 

Shell Maker Utility Program – ShellMaker was released as a standalone utility program.   

ShellMaker is a program which can be used to create a constant-thickness shell around a shape.  

The output of ShellMaker is an STL file which contains the geometry of the shell.  This STL file 

can then be loaded as a shape into a SOLIDCast model, as with any other STL file.  In this way, 

the shell then becomes part of the model and is NOT created using the "Shell" option for mold 

creation when meshing.  This allows such things as insulation or sand beds to be added 

externally to the shell, and also allows multiple shells to be created. 
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Changes and Updates Through Version 6.1.10 

December 19, 2002 

 

Constant-Position Move Window - The Move Shape window which appears when selecting 

“Edit... Move Selected Shape(s)” in SOLIDCast now will be located wherever the user moved it 

when it was last used.  In previous versions, this window always appeared in the middle of the 

screen, which might not be convenient if using the Pick Point or Mouse Click move functions.  

Now, if the user moves this window to a corner of the screen, the next time it appears it will be at 

that same corner. 

 

Fixed Zero Snap Error – The previous version of SOLIDCast allowed the user to activate the 

Snap to Grid function in System Parameters with a 0 dimension for the Snap increment.  This 

caused errors in various functions.  This has been corrected so that a 0 Snap increment can no 

longer be set. 

 

Remove FLOWCast Data in File Menu – In the previous version, the only way to remove 

FLOWCast data was by deleting a Mesh (and any associated simulations) from the Project Tree.  

FLOWCast files can be considerably larger than SOLIDCast mesh/simulation files for runs 

where a lot of nodes are used and where small time step increments are stored.  This new feature 

on the File Menu allows the user to delete the FLOWCast data (assuming that all desired output 

has been captured) while still retaining the SOLIDCast mesh and simulation files.  A Mesh with 

FLOWCast data must be selected on the Project Tree in order for this feature to be active. 

 

Speed Increase in FLOWCast Solver – The “Full CFD” analysis used in FLOWCast has been 

increased in speed by a factor of from 2 to 14 or more, depending on the number of nodes in the 

model.  Models meshed with higher nodes will show the higher speed increase factors. 

 

Real-Time Movies in FLOWCast – FLOWCast now has an option to create AVI (movie) files 

in which the filling is represented in real time.  For example, if the filling of the cavity takes 20 

seconds, the movie file will show the cavity filling on 20 seconds.  The user also has the ability 

to specify the frame rate of AVI files so that movies can be created in slow motion or fast 

motion. 

 

Larger Output Files in FLOWCast – FLOWCast previously encountered a problem when 

creating output files (time_steps.bin) larger than 2GB in size.  This limit has been expanded to 4 

GB.  FLOWCast has also been modified so that, if the 4 GB limit is exceeded, the program will 

keep running a simulation but stop recording time steps.  File sizes this large are usually only 

encountered with very large models (high node count) and small time steps. 

 

Choice of Displaying Scale and Axis Position in FLOWCast – The Graphics menu in 

FLOWCast now allows the user to turn on or off the color key scale and the display of axis 

directions. 
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Changes and Updates Through Version 6.1.3 

September 19, 2002 

 

Manual Additions and Numbering Changes – The SOLIDCast, OPTICast and FLOWCast 

manuals were all updated, and a new numbering scheme was implemented. Instead of continuous 

numbering from beginning to end, each section is now numbered. In the future, when sections are 

revised, you need only print out the revised sections, without having to reprint the entire manual. 

 

FLOWCast™ – The FLOWCast flow modeling package based on Altair flow simulation 

technology has now been released with Version 6.1.2. 

 

Add Shape by Clicking - The ability to fill the Add Shape coordinate fields by clicking on a 

point on the model surface was added.   

 

Self-Correcting Code for Cooling Curves – In some circumstances, cooling curves could be 

corrupted by changing alloy data or loading/saving operations.  New code has been added which 

makes the cooling curves “self-correcting” when changes are made. 

 

Riser Design Wizard – The Riser Design Wizard has been modified so that changing the 

Casting:Riser Modulus Ratio automatically changes the Required Riser Modulus.  Also, the 

order in which the cursor moves between fields when the Tab key is pressed has been corrected. 

 

Graphic Display – The user can now turn on or off the Graphic Display During Solidification 

from a new entry in the System Parameters menu. 

 

FLOWCast Time Step Parameters – The user can now specify the Time Step Parameter to use 

in Auto-Run FLOWCast simulations from the System Parameters menu. 

 

File Size Control – In some systems, the size of the material selection file was found to be 

growing with extra data entries.  This can cause the system to slow down noticeably when 

performing project load or save functions.  This has now been fixed, and all material selections 

files are automatically trimmed to the correct length. 

 

New FileSplitter Utility Program – A new Utility Program to split and recombine files was 

added.  This allows the user to split a large file into multiple small files, and later recombine the 

pieces, for emailing where file size is a consideration. 

 

New Cylinder Intersection Utility Program – A new utility was added which allows the user to 

generate an STL file for the case where two cylinders intersect with a given fillet radius. 

 

System Code Reminder Screen – When SOLIDCast, OPTICast or FLOWCast license codes are 

close to expiring, a reminder screen will now flash when SOLIDCast is started.  When this 

appears, contact Finite Solutions, Inc. for new codes. 

 

Expanded Materials Database - Many new copper base alloys have been added to the database. 

 

Prior to release of Version 6.1.2: A patch was put into the Riser Design Wizard to fix a 

problem associated with Windows NT.  6/5/2002 
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Changes and Updates Through Version 6.0.11 

March 15, 2002 

 

The following new features were added to version 6.0.11 of SOLIDCast: 

 

Riser Design Wizard – The Riser Design Wizard is a new method that uses simulation to help 

you to design a feeding system for your casting. The first step is to run a simulation of the part 

alone. This uses your actual casting alloy and mold material, and could even use gating, if that 

were known. Next, the Wizard converts solidification information into effective modulus data, 

which can then be used to design risers. Feeding paths are automatically calculated, and you can 

account for the variable feeding characteristics of sand risers, or insulating or exothermic 

materials.  

 

Once the risering system has been developed, you can then run a confirming simulation, to see 

that the system will work as required. If true optimization is desired, this model can than be used 

as the starting point for an OPTICast™ optimization run. 

 

New Move Command – There have been three additions to the Move Command: 

 From – To mouse clicks, when working in an orthogonal view 

 Pick Point surface clicks, when working in any view, including the rotating view 

 Undo Last Move function 

 

“Sticky” Color Selection in Iso-Surface Plot – When doing multiple iso-surface plots, the 

system now retains the last color choice, and uses it as the default for the next plot. This choice 

will be retained even if you exit the system. 

 

Improved Movie Making Functions – In some cases, the movie making function could fail due 

to an improper file or path name. The software now checks and validates the path and file names 

prior to running a movie operation. 

 

Reminder Screen When Close to Expiration – Under the current licensing scheme, the system 

displays, at startup or whenever you access the …About SOLIDCast… screen, how many days 

remain on the support contract. This is the number of days that the software will remain active 

and functioning on that computer. When this number reaches 0, the software will stop working. 

A new Reminder Screen has been added, so that when the number of days starts to get low, the 

screen will give you directions on how to get new Response Codes from Finite Solutions, Inc, to 

extend the use of your software. Previously, no instructions were given, and if you did not notice 

that the days were reducing, your system could shut off unexpectedly. 
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Changes and Updates Through Version 5.5.34 

25-April-2001 through 26-January-2002 

 

 

11/29/01 Stabilized System Code 2 so that it does not change each time the codes are 

viewed 

 

11/29/01 Created standalone program for plotting mold fill times using Custom-Low 

parameter 

 

11/20/01 Fixed metric conversion problem with CFS and Niyama points when importing a 

component 

 

11/9/01 First standalone version of Riser Design released 

 

11/7/01 Released Russian version of SOLIDCast 

 

11/4/01 Created standalone program for outputting STL files from SOLIDCast models 

 

11/2/01 Fixed problems with computer ID's changing after activation 

 

9/20/01 Added network security version 

 

9/18/01 Metric conversions in OPTICast Pin Points and Temperatures fixed 

 

9/18/01 Added Copy System Codes to clipboard 

 

9/18/01 Added a feature to simulate heat/hold cycles for heat treating 

 

9/17/01 Regional/locale problems fixed: Entering plot values, Create New Optimization 

Project 

 

9/12/01 Fixed coordinate display in CutPlane function 

 

9/7/01 Changed Security Code format to current format with letters and numbers 

 

9/5/01 Fixed thermocouple coordinates in metric 

 

8/3/01 Added Maintain Aspect Ratio feature to OPTICast 

 

8/2/01 Released Version 5.5 with OPTICast Module capability 

 

7/29/01 Fixed problem with materials in cloned model (Error 11 occurs in Curves tab) 

 

7/11/01 Fixed field editing for negative numbers (- sign could not be typed first) 

 

7/11/01 Fixed OPTICast error in Geometric Design Variable numbering 

 

7/8/01 Metric error in Model… Options fixed 



7/5/01 Added Time Delay for cooling channels with high/low limit controls 

 

7/3/01 Detail level in CastScan not being recorded properly … fixed 

 

6/27/01 Ignition temp. did not "stick" after being entered… this was fixed 

 

6/27/01 Component file offset not working.  This was fixed 

 

6/26/01 Fixed numeric fields so alphabetic keystroke can't kill program 

 

6/26/01 Plot values now "stick" after being entered 
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Version 5.20.49           April 24, 2001 

 

The following three fixes were added to version 5.20.49: 

 

Internal HT Coefficients: When Internal HT Coefficients are 

selected, the system was assigning a HTC value of 0 to surfaces 

between Fill Material and other materials in the model. This has 

been corrected so that Fill Material now uses the same HTC that 

is specified for Riser Material. 

 

Thermocouple Data: When using a thermocouple, in the TCDATA.TMP 

output file the location of the thermocouple was always given in 

inches. This has been corrected so that the location is given in 

mm if the system is set to Metric Units. 

 

CastPic errors: Windows NT and Windows 2000 machines would 

periodically get an error which would shut down SOLIDCast™ when a 

CastPic report was requested. This has now been fixed. 

 

The following new features and changes were issued as of Version 

5.20.49: 

 

Model Locking: When a model has been meshed the system now puts 

the model into a “read-only” mode where the model cannot be 

changed.  You can examine all of the model parameters, but shapes 

cannot be added, changed or deleted.  If you want to change the 

model, you can either delete the mesh (and simulation, if there 

is one), then double-click on the “Model” entry on the Project 

Tree to unlock it… or you can highlight the model entry on the 

Project Tree and select File… Clone Model to create a copy of the 

model that can be changed, preserving the original model. 

 

Last-Four Projects:  When you select File from the menu, the last 

four projects saved are displayed so that all you have to do is 

click on one of these to load that project. 

 

Surface Pick Point:  When you are in Model View, you can click 

the mouse anywhere on any model shape surface, and the (X,Y,Z) 

coordinates of that surface point will be displayed in the 

information bar under the window.  This is similar to probing the 

surface of the model with a CMM probe. 

 

Coordinates in Cut Plane Display:  In some of the Cut Plane 

views, the coordinates of the mouse click point were not being 

correctly calculated.  This has been corrected. 

 

Cooling Channels:  There were several errors identified in both 

the user interface and the simulation program affecting the data 

entry and the operation of cooling channels during a simulation 

run.  These errors have now been fixed, and the cooling channel 

type of material should function correctly. 

 



Display of Graphics:  The presence of the file $graphic.500 

causes the system to display an image of the casting during 

filling and solidification.  This display has been modified so 

that, during filling, the display is not update as often.  This 

means that the filling portion of a simulation, with the graphics 

turned on, will run much faster than previously.  Also, during 

filling, the temperature range of the colors in the display has 

been adjusted so that the system is plotting the minimum and 

maximum temperatures as the range, rather than from pouring to 

solidification.  This results in a much greater differentiation 

of the colors during the mold filling portion.  At the end of 

mold filling, the color range reverts to the range from pouring 

to solidification temperature. 

 

Thermocouple Data Output:  Use of a High Limit or Low Limit type 

of cooling channel creates a file of thermocouple data in the 

simulation output folder called TCDATA.TMP.  Previously, this 

recorded time/temperature data at each time step, which could 

result in very large files. It is now possible to create a small 

text file called $tcinc.500 in the AFSolid 2000 installation 

folder (this folder is normally c:\Program Files\AFSolid 2000).  

This $tcinc.500 file can be created with NotePad or any other 

Windows program that can create a text file.  This file should 

contain a number which specifies the time step increment for 

writing time/temperature data.  For example, suppose that the 

file $tcinc.500 exists and contains the number 10.  This means 

that any time/temperature data will be written only every 10 time 

steps instead of every time step.  By using this method, the 

amount of time/temperature data can be reduced significantly. 

 

Changing an Exothermic Material with an Ignition Temperature to 

one Without an Ignition Temperature:  Previously, if you were 

using an exothermic material and specified an Ignition 

Temperature, then turned OFF the Ignition temperature, the system 

would still act as though an Ignition Temperature had been 

specified for that material.  The reverse procedure was also 

incorrect, i.e., if you had an exothermic material with the 

Ignition Temperature turned OFF on the mold material list, and 

then later turned ON the Ignition Temperature, the simulation 

would still act as though the Ignition Temperature were turned 

off.  This has been fixed. 
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Version 5.20.24         January 31, 2001 

 

The following new features and changes were issued as of Version 

5.20.24: 

 

01/31/01 

Revised the View Factor calculation so that the maximum HTC uses the External HT Coefficient entered by 

the user. Previously, this value was hard-coded to a value of 10. 

 

01/30/01 

Added a Low-Pressure Permanent Mold feature that reverses the gravity direction at the end of filling. 

 

01/29/01 

Revised View Factor calculations so that it applies to ALL external surfaces, not just those created by 

meshing a shell or mold. 

 

01/25/01 

Developed a list of supporting DLL file versions, sizes and dates required to operate the movie creation 

functions. 

 

01/23/01 

Fixed "File not found" error which occurred at the end of making an Iso-Surface movie. 

 

01/23/01 

Revised InstallShield installation script to ensure that a "Phantom Reality" text banner does not appear over 

movies. 

 

01/11/01 

Fixed two errors occurring in European regions: 

1. Weights were not correctly shown. This has been corrected. 

2. "Time stop" parameter was not correct when fraction minutes were specified. This has been corrected. 

 

01/06/01 

Fixed an error which occurred when doing a ring copy of multiple shapes with a small angle increment, 

where the resulting shape angles were slightly offset. 

 

12/26/00 

Fixed an “Error 9: Subscript out of range" error which sometimes occurred when selecting shapes in the 

model. 

 

12/19/00 

Added a feature which prevents a user from deleting a material from the Mold Material List, if that material 

is in use in the model. 

 

12/15/00 

Fixed problems with Cut Plane being out of location in the model. Also modified the cut plane so that it is 

visible with either black or white background, and does not disappear when the model is rotated. 

 

12/05/00 

Fixed the Component Import feature so that, if the component is imported into a blank model space, the 

selected alloy changes to match the alloy used in the component. 
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Version 5.20         November 28, 2000 

 

The following new features and changes were issued as of Version 

5.20: 

 

AFSolid 2000™ now has the ability to create AVI files, which are 

standard Windows animation files, to illustrate the results of 

simulations.  These files can be viewed with the Windows Media 

Player.  The first type of movie available is the Iso-Surface 

Movie.  This allows the user to automatically create a series 

of Iso-Surface images showing progressive values, which are 

then compiled into an AVI file. 

 

CutPlane Movies allow the user to select a cut plane through the 

casting model and then create an animated image showing the 

progression of solidification time, critical fraction solid 

time or other data on that 2D cut plane. 

 

CastPic Movies allow the user to create animated images using the 

CastPic function, which creates a 3D image of the casting with 

data mapped onto the surface as colored areas.  This can show 

the exterior surface of the casting, or the casting can be cut 

to show interior data as well. 

 

CastScan Movies are a new type of display incorporated into an 

animation function.  The CastScan display creates a 3D image 

of the casting and, within this 3D image, creates one or more 

Iso-Surfaces.  These Iso-Surfaces can be incrementally colored 

so that areas of most concern are the most visible.  CastScan 

Movies can be created in two types: 

 

• Rotating CastScan Movies show an image of the casting 

rotating in 3D space, with the data plotted inside this 

image.  This function gives a good feel for where 

indications within the casting actually are located. 

• Progressive CastScan Movies show an image of the casting 

fixed in space, with the data (such as solidification time 

or critical fraction solid time) plotted progressively to 

show an animated image of how the casting cools and 

solidifies. 

 

Version 5.20 now allows the user to save and load Component 

Files.  One or more shapes within a model can be selected and 

saved as a component file, then these components can be 

imported into other models.  This allows the user to create a 

library of standard shapes (such as risers or gating 

components) and re-use them over and over.  This also allows a 

convenient method for saving a partial or complete model and 

bringing this into a new model file.  All material properties 

are also saved along with the component. 

 



A new Clone Model function allows you to automatically create a 

copy of a model within a project.  This permits the user to 

copy a model, edit it and run a simulation, then make another 

copy to edit and run a simulation, and so on.  In this way, 

each design iteration is maintained so that you can go back 

and review each step in the design process. 

 

Mirror Data is a new function that allows you to mirror results 

about a Plane of Symmetry.  For example, in the past when you 

placed a Plane of Symmetry onto a casting model and ran a 

simulation, the results were visible only on the portion of 

the model outside the plane of symmetry.  The Mirror Function 

mirrors the result data so that data can be plotted throughout 

the entire model.  (Note:  This is available only for Planes 

of Symmetry that are not rotated.) 

 

A new output function called the FCC Criterion can now be 

calculated and plotted from with AFSolid 2000™.  The FCC 

Criterion was developed as an indicator of total evolved 

microporosity (structural microporosity) in aluminum castings.  

It has been found to be useful in ferrous alloys as well to 

predict microporosity. 

 

AFSolid 2000™ now has the ability to set and adjust Tilt Pour 

Angles to simulate the filling of permanent mold processes 

using the tilt pour method. 

 

A new parameter has been included in System Parameters which 

specifies the maximum number of facets in a single Iso-

Surface.  When plotting an Iso-Surface, the system will now 

automatically reduce the surface detail if this number is 

exceeded.  This helps to avoid long plotting times for Iso-

Surfaces on models with large numbers of nodes. 

 

In previous versions of AFSolid 2000™, when extruded shapes were 

created where the minimum and maximum locations of the end 

planes were reversed, or when revolved shapes were created 

with the minimum and maximum angles of rotations reversed, the 

shapes did not mesh.  This has been corrected. 

 

In previous versions of AFSolid 2000™, when using Metric Units 

and revolving a Plane of Symmetry to an angle, the angle of 

the Plane of Symmetry revolution was incorrect.  This has been 

fixed. 

 

 

 



Version 5.10         August 8, 2000 

 

The following changes were made as of Version 5.10: 

 

The Cut Plane plots have been significantly improved.  The actual 

geometric outline of the casting can now be seen on the plots 

and is used as the border of the plot area, eliminating the 

“stair-step” outlines which were previously visible.  Areas 

outside the plot range are now plotted in color.  Previously, 

in some plots where the entire cross section was outside the 

plot range, no image was visible on the Cut Plane; an exact 

image of the casting is now visible at all Cut Plane 

locations.  The contour of the casting is now shown in outline 

when plotting temperature of both casting and mold. 

 

It is no longer necessary to change the Windows Regional Settings 

to “United States” when running the software.  The software 

should now be capable of running properly in European regional 

settings. 

 

A Sketch function has now been added to AFSolid 2000™. When 

selecting either an Extruded Solid or a Solid of Revolution, 

the user can now sketch a cross section on the screen, using 

the mouse, to create a three-dimensional solid. The current 

setting of the “Snap to Grid” System Parameter is used when 

sketching a shape.  This function can be particularly useful 

for adding gates, riser contacts, chills or fill material to 

casting models. 

 

The Import function for 2D shapes (AFSCad and DXF files) has been 

significantly enhanced.  The system now allows the user to 

specify a specific orthogonal view when importing a 2D shape 

from a file, and checks for such conditions as an axis of 

revolution passing through a shape.  This allows shapes to be 

imported in all major orthogonal views, which was not 

previously the case.   

 

Solids of Revolution in which the 2D shape was sketched on the 

negative side of the axis did not previously mesh properly.  

This has been fixed. 

 

The “Add Shape” window has been modified so that it stays on the 

screen after adding a shape.  Also, if the user is selecting 

files from a particular folder for import (such as STL, DXF or 

AFSCad files), the selection of the folder does not revert 

back to the System Parameter “Import” setting as long as the 

Add Shape window is not closed.  This means that multiple file 

imports can be processed much more quickly, without having to 

navigate through menu selections and folders each time. 

 

In previous versions, when performing a Cut Plane Plot and then 

immediately afterward performing an Iso-Surface Plot, the 

system would sometimes display an “Illegal function” message 

and terminate the program.  This has been fixed. 



 

In previous versions, when values were entered for a Plane if 

Symmetry and then the Plane of Symmetry window was re-opened, 

the values were factored by 25.4.  This has been corrected. 

 

A new Security System has been activated with Version 5.10. For 

systems which were installed prior to Version 5.10, a new 

password will be required after installation of Version 5.10. 

 

 

Other changes made in previous versions: 

 
New features and bug fixes applied since 20 December 1999 
 
AFSolid 2000 Version 5 
 
March 27, 2000 
 
1 -- Shape editing features, and shape grouping features, have been 
added. All new features are located in the "Edit" menu, once a model has 
been loaded. 
 
February 24, 2000 
 
1 -- Improvements to CastPic have been implemented, allowing better 
pictures of complex models with many fill shapes 
2 -- A metric conversion bug has been fixed, which was causing new 
rectangle parametric shapes to be sized incorrectly. 
3 -- Menu key shortcuts for many common functions have been added.  
 
January 24, 2000 
 
1 -- Updated supporting graphics libraries and made a small change to 
the CutPlane generation report function. 
 
January 17, 2000 
 
1 -- Fixed a minor bug in the Start Simulation dialog box. With only one 
mesh associated with a model, there were intermittent error messages. 
This is no longer occurring. 
 
2 -- Repaired a problem with the Materials Lists. With HT Coefficients 
turned on, the system was writing incorrect materials lists for meshing. 
This had to do with the presence of HT coefficients for materials that 
had been deleted from the materials list. This is repaired; the system 
now removes any HT coefficients which contain nonexistent materials, and 
also any HTC's with a value of 0. 
 
3 -- Weight calculations for each mesh are present. After meshing choose 
the "Mesh" menu, followed by "Weights", to see a weight calculation for 
the mesh. 
 
4 -- Planes of Symmetry are active. When viewed, the system displays a 
white-translucent box around the parts of the model cut out for meshing. 
Choose the "View" menu, and toggle "Planes of Symmetry" on and off to 
visualize or hide the planes. Choose "Tools", then "Planes of Symmetry" 
to manipulate them. 
 



5 -- A cosmetic display problem with Planes of Symmetry has been 
addressed. Users with very large STL files were shown a plane-of-
symmetry graphic which did not correctly show which parts of a model 
would be mirrored. The system now displays this correctly. 
 
4 -- Various issues with the system regarding display and conversion of 
metric values have been addressed and fixed. It appears at this point 
that all the metric issues are addressed. 
 
5 -- The "Create Mesh" dialog box now saves user-applied settings, so 
that node count and node size do not reset. 
 
January 5, 2000 
 
1 -- changed the menu structure a bit, as follows: 
 
The menus "Model", "Mesh", and "Simulation" are no longer simultaneously 
visible. Instead, the appropriate menu appears when a model, mesh, or 
sim is selected from the tree view, and the other two menus are rendered 
invisible. Please let me know if you encounter any situations where a 
menu isn't there when it should be. 
 
This change makes the application behave more like other Windows apps, 
where unavailable menus disappear when not relevant. 
 
2 -- Weight calculation is implemented, off of the "Mesh" menu. Select 
any mesh, and choose "Weights" from the menu. A dialog box will appear 
listing the contents of the weights.dat file for the mesh, converted 
into metric units if appropriate. 
 
3 -- Removed a directive in the program which was preventing the system 
from starting if the system date was set to a date later than 31 
December 1999 

 


